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12.

Notice

All information included in this document is current as of the date this document is issued. Such information, however, is sub-
ject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please con-
firm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to ad-
ditional and different information to be disclosed by Renesas Electronics such as that disclosed through our website.

Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights
of Renesas Electronics or others.

You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of
semiconductor products and application examples. You are fully responsible for the incorporation of these circuits, software,
and information in the design of your equipment. Renesas Electronics assumes no responsibility for any losses incurred by
you or third parties arising from the use of these circuits, software, or information.

When exporting the products or technology described in this document, you should comply with the applicable export control
laws and regulations and follow the procedures required by such laws and regulations. You should not use Renesas Electron-
ics products or the technology described in this document for any purpose relating to military applications or use by the mili-
tary, including but not limited to the development of weapons of mass destruction. Renesas Electronics products and technol-
ogy may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any
applicable domestic or foreign laws or regulations.

Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics
does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages in-
curred by you resulting from errors in or omissions from the information included herein.

Renesas Electronics products are classified according to the following three quality grades: “Standard”, “High Quality”, and
“Specific”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as
indicated below. You must check the quality grade of each Renesas Electronics product before using it in a particular applica-
tion. You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior written
consent of Renesas Electronics. Further, you may not use any Renesas Electronics product for any application for which it is
not intended without the prior written consent of Renesas Electronics. Renesas Electronics shall not be in any way liable for
any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an applica-
tion categorized as “Specific” or for which the product is not intended where you have failed to obtain the prior written con-
sent of Renesas Electronics. The quality grade of each Renesas Electronics product is “Standard” unless otherwise expressly
specified in a Renesas Electronics data sheets or data books, etc.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support.

“Specific”: Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life.

You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics,
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or
damages arising out of the use of Renesas Electronics products beyond such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have spe-
cific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further,
Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a

Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system
manufactured by you.

Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibil-
ity of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all applicable laws and
regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive.
Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with applicable
laws and regulations.

This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas
Electronics.

Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-

owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.




Disclaimer

By using this Renesas Starter Kit (RSK), the user accepts the following terms:

The RSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK is as-
sumed by the User. The RSK is provided by Renesas on an “as is” basis without warranty of any kind whether ex-
press or implied, including but not limited to the implied warranties of satisfactory quality, fithess for a particular pur-
pose, title and non-infringement of intellectual property rights with regard to the RSK. Renesas expressly disclaims all
such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data, loss of contract,
loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall costs (whether
the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other direct or indirect
special, incidental or consequential damages arising out of or in relation to the use of this RSK, even if Renesas or its
affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK product:

This Renesas Starter Kit is only intended for use in a laboratory environment under ambient temperature and humidity
conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the
laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the
Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the equip-
ment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not is use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 10m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the regula-
tory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of the RSK hardware functionality, and electrical
characteristics. It is intended for users designing sample code on the RSK platform, using the many different incor-
porated peripheral devices.

The manual comprises of an overview of the capabilities of the RSK product, but does not intend to be a guide to
embedded programming or hardware design.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RL78G13 Group. Make sure to refer to the latest versions of these docu-
ments. The newest versions of the documents listed may be obtained from the Renesas Electronics Web site.

Document Type Description Document Title Document No.

User’s Manual Describes the technical de- RSKRL78G13 User’s R20UT0459EG
tails of the RSK hardware. Manual

Tutorial Provides a guide to setting RSKRL78G13 Tutorial R20UT0460EG
up RSK environment, running Manual
sample code and debugging
programs.

Quick Start Guide Provides simple instructions RSKRL78G13 Quick Start R20UT0461EG
to setup the RSK and run the Guide
first sample, on a single A4
sheet.

Software Help Describes the functionality of RSKRL78G13 Software R20UT0746EG

Manual the sample code. Help Manual

Schematics Full detail circuit schematics RSKRL78G13 Schematics R20UT0458EG
of the RSK.

Hardware Manual Provides technical details of RSKRL78G13 Hardware RO1UHO0146EJ
the RL78G13 microcontroller. Manual




2. List of Abbreviations and Acronyms

Abbreviation

Full Form

ADC Analogue to Digital Converter
API Application Programming Interface
CD Compact Disk

CPU Central Processing Unit

El E1 Emulator

LCD Liquid Crystal Display

LED Light Emitting Diode

ROM Read-Only Memory

RSK Renesas Starter Kit

RTC Real Time Clock

usB Universal Serial Bus
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LENESAS

RSKRL78G13 R20UT0460EG-0100
Rev.1.00
RENESAS STARTER KIT Jun 21, 2011

1. Overview

1.1  Purpose

This RSK is an evaluation tool for Renesas microcontrollers. This manual describes how to get the RSK tutorial
started, and basic debugging operations.

1.2 Features

This RSK provides an evaluation of the following features:
« Renesas microntroller programming

» User code debugging

« User circuitry such as switches, LEDs and a potentiometer
« Sample application

« Sample peripheral device initialisation code

The RSK board contains all the circuitry required for microcontroller operation.

R20UT0460EG-0100 Rev. 1.00 - QENES NS Page 7 of 30
Jun 21, 2011



RSKRL78G13 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, the most common questions asked about using a Renesas
Starter Kit (RSK). The tutorials help explain the following:
« How do I compile, link, download and run a simple program on the RSK?

« How do I build an embedded application?
o How do | use Renesas’ tools?

The project generator will create a tutorial project with two selectable build configurations.
» ‘DefaultBuild’ is a project with debug support and optimisation level set to two.

» ‘DebugBuild’ is a project built with the debugger support included. Optimisation is set to zero.
» ‘ReleaseBuild’ is a project with optimised compile options, producing code suitable for release in a product.

Files referred to in this manual are installed using the project generator as you work through the tutorials. The tuto-
rial examples in this manual assume that installation procedures described in the RSK Quick Start Guide have been
completed. Please refer to the quick start guide for details of preparing the configuration.

These tutorials are designed to show you how to use the RSK and are not intended as a comprehensive introduction
to the CubeSuite+'s debugger, compiler toolchains or the E1 emulator. Please refer to the relevant user manuals for
more in-depth information.

R20UT0460EG-0100 Rev. 1.00 - QEN ESNS Page 8 of 30
Jun 21, 2011



RSKRL78G13 3. Tutorial Project Workspace

3. Introduction to Code Generator

3.1 Whatis Code Generator

Code Generator is a design tool which enables you to output the source code (device driver programs, C source
files and header files) necessary to control the peripheral hardware functions provided by the microcontroller de-
vice (clock generator, port functions, etc.) by configuring various information using the GUI. This tool is integrated
into CubeSuite+.

3.2 Features

The Code Generator has the following features:

- Reporting function
You can output configured information using the Code Generator as files in various formats for
use as design documents.

- Renaming function
The user can change default names assigned to the files output by Code Generator and the API
functions contained in the source code.

- Code generating function
Code Generator can output not only device driver programs in accordance with the information
configured using the GUI, but also a build environment such as sample programs containing main
functions and link directive files.

- Project/workspace file generating function

3.3 Code Generation

The following steps serve as a short presentation of how to generate source code using the Code Generator design
tool. It assumes that a project already exists and is opened.

For more details on how to use Code Generator, refer to the document “CubeSuite+ V1.00.01 Integrated Develop-
ment Environment User’s Manual: RL78 Design”.

« Double-click the Code Generator (Design Tool) _
from the Project Tree pane to reveal the list of pe- +°J Code Generator {Design Tool)
ripherals. -

« The project tree shows all configurable peripherals p! Clock Generator

i

of the selected device. n Fort
o The exclamation mark on the Clock Generator will w' Intemupt
disappear after the Pin Assignment configuration; w' Senal
shown in the screen-shot that follows the one oppo- n A0 Corverter
site to this text. ' Timer
« The Watchdog Timer module is configured and en- —" @ Watchdog Timer
abled by default; indicated by the open box. w' Realtime Clock
' Interval Times
n' Clock Qutput/Buzzer Outp
w' DMA Controlles
w' Yoltage Detector
R20UT0460EG-0100 Rev. 1.00 RENES NS Page 9 of 30

Jun 21, 2011



RSKRL78G13

3. Tutorial Project Workspace

« Click on the < Fix settings > button.

« The “Clock setting’ tab contains options for config-
uring the clocks.

« The “On-chip debug setting’ tab contains an option
to enable/disable debugging and the use of a secu-
rity ID. Ensure to set the ‘On-chip debug operation
setting’ to “Used’ for debugging projects.

« The icons highlighted in the opposite screen-shot
shows the available peripherals that can be config-
ured. Click each icon to open the settings view and
configure the desired peripherals.

« Click on “‘Generate Code’ after configuring all de-
sired peripherals, to generate the project source and
header files.

« The generated files will automatically be created
and placed in the project folder.

Note: If files of the same name already exist in the IDE
project folder, it may be necessary to back-up the old
files before overwriting them.

Mndu\e‘ File: ‘ Froperty ‘

°J Generate Cade | % S ¢ .;'_" “:”\[‘, 'f) & E @ <49 ,é; =

FPin assignment | Clock setting | On-chip debug setting | Confirming reset source | Safety functions
Pin assignment setting

[ PIORO bt = 1
[7] PIORT bit=1
[7] PIOR2 bit=1
[C] PIOR3 bit=1
[7] PIOR4 bit=1

mn

‘when it's decided once, it isn't possible ta change it later.
It's necessary to make a project again to change it.

[ Fix settings

Fin Function
P17 TIn2/T002

=1 hlietadulie]

Module| File | Froperty |
CJ Generate Code | o=

WO S0P E

GJ Generate Code

Note: The Application sample project is an empty sample project with temporary files generated from Code Gen-
erator. Users are encouraged to use Code Generator to generate the source files containing API functions based on
their application development’s requirements and use them in the Application sample project.

R20UT0460EG-0100 Rev. 1.00
Jun 21, 2011
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RSKRL78G13 3. Tutorial Project Workspace

4.Tutorial Project Workspace

The project includes all of the files required to get started. The tutorial code is designed to show how code can be
written, debugged and then downloaded.

Contents of common C files are controlled with defines set up in the build configuration options and #ifdef state-
ments within the source files. Maintaining only one set of project files means that projects are more controllable.

R20UT0460EG-0100 Rev. 1.00 - QENES NS Page 11 of 30
Jun 21, 2011



RSKRL78G13 4. Project Workspace

5. Project Workspace

51 Introduction

CubeSuite+ is an integrated development tool that allows the user to write, compile, program and debug a software
project on the 78K, RL and V850 family of Renesas Microcontrollers. CubeSuite+ will have been installed during
the installation of the software support for the Renesas Starter Kit product. This manual will describe the stages
required to create and debug the supplied tutorial code.

5.2  Starting CubeSuite+ and Connecting the E1 Debugger

To look at the program, start CubeSuite+ from the Windows Start Menu.

The first time CubeSuite+ is started, the One Point Advice dialog box will be shown:

Cne Point Advice

® CubeSuite+

To gelect a panel with the keyboard:

Press the [Cird] + [Tab] keys to display the dialog box for
selecting panels and the editor’s focus.

Select the desired panel with the [Tab] key and/or the amow keys

* Displayed contents, random.

ws /2
[] Do ot show this dialog box at startup

The One Point Advice dialog box provides some useful tips when using CubeSuite+. Press < OK> to skip the ad-
vice and close the One Point Advice dialog. The user will then be presented with the Start panel which contains six
sections.

Under the ‘Open Sample RSK Project’, open a new Tutorial project by selecting the RSKRL78G13_Tutorial pro-
ject template and click on *Go’ as shown below. This will save a copy of the RSKRL78G13_Tutorial project.

B

Select an RSEK project template from those installed:

RSERL78G13 Tutarial

Add all sub-projects by clicking on the tick-box next to each sub-project name. Information on each sub-project is
listed below the ‘Subproject information’ heading.

R20UT0460EG-0100 Rev. 1.00 - QENES NS Page 12 of 30
Jun 21, 2011



RSKRL78G13 4. Project Workspace

CubeSuite+ will present a ‘Create Project’ dialog as seen in the next screenshot below.

[ Create Project [EJ @1

Subprojects ta Add Subpraject infarmatian ;
Szwnc_Senal » | |ADC Oneshot
DAL Demonstration of the ADC module, in
IC_Hd aster oneshot mode.
The program configures the ADC tao
IC_Slave . :
LIN perform A/0 corwverzions after a switch
prezz and displays the resulks on the
LD =|| |debug LCD.
RTC The uzer can switch between S-hit and 10-
Sync_Seral bit _pricisicun modes by prezsing user
Timer switches.
WhDT -

Mame: RSKRLAZG12 Tutorial

Location - CMWASERLYSGT3_Tutonial Browze, . |

b ake the project folder

Create || Cancel || Hep |

« Select all sub-projects by clicking on each tick-box and observe the information displayed under the *Subproject
information:” heading as you click on each tick-box.

« Enter a name in the ‘Name’ field as shown above.

« Specify a folder where the project is to be saved.

« Click on <Create>.

« Adialog will appear if the location specified does not exist; asking to create the folder specified.
« Click on <OK>.

» CubeSuite+ will create the project in the specified folder. A number of dialogs will appear consecutively as each
sub-projects is added to the main project.

To view the file project source files, double click on the files listed in the Project Tree window. A new window will
open showing the code.

Note: A different name and location may be specified.

R20UT0460EG-0100 Rev. 1.00 - QENES NS Page 13 of 30
Jun 21, 2011



RSKRL78G13 4. Project Workspace

« The Project Tree as seen in CubeSuite+. Praject Tree
o RSKRL78G13_Tutorial (Project) is the master A @ 8
project and includes the tools shown on the oppo- —
site screenshot. =1 T3 RSKRLT2G13 Tutorial (Project)

I RSFLO0LE (Microcontroller)

le Code Generator (Design Tool)
Ay, CATIKOR (Build Tool)

2 BLTS Simulator (Debug Toal)

f:’ Prograrm &nalyzer (Analyze Tool)
1 File

j'_a, AOC_OneShot (Subproject)

]'_a, ADC_Repeat (Subproject)

]'_a, Application (Subpraoject)

« The File folder seen in the screenshot belongs to
the master project, RSKRL78G13_Tutorial.

» This folder contains and lists all project source and
header files including text files arranged in sepa-
rate folder structures.

» Folders containing the subprojects, indicated by
“(Subproject)”, are listed below the File folder.

» Each subproject folder, when expanded, reveals an
identical tools and folder structure to that of the
master project being RSKRL78G13_Tutorial.

« By default the RSKRL78G13_Tutorial project is
set as the active project, indicated by the line un-
der the project name.

« To change the active project, right-click on the
project/subproject name and select “Set _ as Ac-
tive Project” (___ represents the project name).

]'_s, Azync_Serial (Subproject)
]'_a, DrALC CSubproject)

]'_a, IC_Master (Subproject)
]'_a, OC_Slawve (Subproject)

]'_s, LIM (Subproject)

]'_a, LWD (Subproject)

]'_a, RTC (Subproject)

]'_a, Sync_Serial (Subproject)

| ]'_s, Tirmer (Subproject)

- 73 WOT (Subproject)

« The main project’s default debug tool is set to

‘RL78 Slmulator, = = 3 zop::ty BJ Code Generator L&{ Code Generator |
8 7 e
« To change the debug tool: = [ ASKRLTIGI3 Tutorial (Project) o
. . . .5/ REF100LE (Microcontroller) Part
nght-CIICk on RL78 SImUIator (Debug TOOI) l ode Generatar {Design Toal) : Intermipt
1 -y CATSEOR (Build Tool) ' Senal
Select Using Debug Tool P = A Corvers
Select ‘RL78 E1 (Serial) ! % S_ﬁ”g'amA”a‘ﬂer(A”a'ﬂ” Using Debug Tool »| | Ru78IECUEE
-.[F ADC_Oneshot (Subproject) AR | FUIBELSeraD
b ﬁADC_REpEat (Subproject) ' Clock Ou RL78 E20{3erial)
=L Application (Subproject) w' DMA Con RL78 EZ Ermulator
- T Async_Seral (Subproject) = Vaoltage D
i ED;’I{AC (Subprujej:) ' o - T8KOR Simulator
« The screenshot shown opposite serves as a demon- (3 File
stration of how to change the active project. The E Z Fppiceren Covpoecy

ADC_OneShot subproject is used as an example.

« The File folder contains four subfolders. This
structure is common to all projects.

« All Code Generator generated source files are

RSF100LE (Microcontro ]j Build RSKRLT8G13_Tutorial

| Code Generator (Desig #

4, CATEKOR (Build Tool)

55! RLTS E1 (Serial) (Debug .4 Clean RSKRL73G13_ Tutorial
o

Program Analyzer (Ana

Rebuild RSKRLY8G13_Tutorial

Qpen Folder with Explorer

grouped under the Code Generator folder which it- 5% Startup Add »
self is listed under the File folder in the Project "i r_lk.dr it Set ADC_OneShot as Active Praject
. . e aa st .| | Code G
Tree. These files are prefixed with ‘r_’ to indicate T Comrariee | @l Removefromproject  ift+Del
that they were generated by Code Generator. All L] Text Files & paste e
other user-generated or user-included source files Ny ]| Dependencies p— =
. [+ Ty ADC_Repeat (Subproject)
are listed separately from those of Code Genera- - L& Async_Serial (Subproject) | (]| Property
tor’s. This can be seen above. S Borecm
R20UT0460EG-0100 Rev. 1.00 - QENES NS Page 14 of 30
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RSKRL78G13

4. Project Workspace

» To open a file for viewing, right-click on the file
and select ‘Open’. Alternatively, double-click on
the file.

5.3 Configuring the Debug Tool (E1)

..... 4, CATSKOR (Build Tool)
----- 2= RL78 El(Serial) (Debug Tool)
----- fj Program Analyzer (Analyze Tool)

m

@ Compile

| 7 Open

Note: The Tutorial sample project’s settings are pre-configured. This section serves to helps the user familiarise
themselves with the settings for when they decide to create a new project.

o The Project Tree will be displayed on the left-
hand pane of CubeSuite+.

« This can be invoked from the menu bar [View >
Project Tree].

&3 RSKRLT8G13 Tutorial - CubeSuite+ - [Project Tree] . 0

File Edit

@5 Stan

Uiew|F'ruject Build Debug Tool Window Help

Project Tree

\J'a:sd'-.:s

-+ =

This list contains a number of tools used in configuring the IDE for programming and debugging of the device, as
well as listing source code files. Follow the following instructions to verify the pre-configured settings:

« Right click on CA78KOR (Build Tool)
« Click on Property

« Click on the Link Options tab to open the sheet.

« Expand the Device entry to reveal the sub-entry
options.

« Verify that the Debug monitor area start address
is as shown on the opposite screen-shot.

Project Tree

A
z

@ 8

=

_ﬁ RSKRL78G13 Tutorial (Project]
-

R5F100LE (Microcontroller)
Code Generator (Design Tool)

AJEED Build Too

RL78 EL{Serial) (Debu
i Program Analyzer (A
&-[ File

-] ﬁ Application (Subproj
w-[ % ADC_OneShot (Subp
G- ﬁ ADC_Repeat (Subpro
|_‘!---i ﬁ Async_Serial (Subpro
- | % DMAC (Subproject)

Build Project
Rebuild Project

Clean Project

Set Link Order...

§ Set to Default Build Cpticn for Project

F
Shift+F7

;_}--5 \ﬁ IC_Master (Subprojecs

T
T
&
El
%

Property

Pruperty‘

L

4, CATBKIR Property

System libraries

Additional library paths

System library paths

B Devics
Use on-chip debug
Option byte values for OCD
Debug monitor area start address
Debug monitor area size[byte]
Set user option byte
User option byte value
Specify mirrer area
Set flash start address
Boot area load module file name
Control allocation to self RAM area

System libraries[0]
Additional library paths[0]
System library paths[0]

Yes{-go)
84

[==] FEDO
512

Yes{-gb)
[F==] EFFFE8
MAA=D{mil)
No

No
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4. Project Workspace

« The opposite screen-shot indicates that the se-
lected Debug Tool is E1.

« Right click on RL78 E1(Serial) (DebugTool)
« Click on Property
« View the Connect Settings

« Verify that the settings match with what is shown
on the opposite screen-shot.

Note: to supply external power to the target board,
set the “‘Power target from emulator. (MAX 200mA)’
entry to No.

The project is configured to halt code execution on

the first instruction of the main function after pro-

gramming the microcontroller. To specify another

function as the entry point:

« View the Download File Settings of the RL78
E1’s property.

« Change the ‘specified symbol’ to another avail-
able function.

» Ensure to pre-fix the function name with an un-
derscore (“_").

Note: Do not specify an interrupt handler as the entry

point.

5.4  Build Configuration

Project Tree o x
2028
= Jﬁ RSKRL7EG13 Tutorial (Project)

B RSF100LE (Microcontroller)
Code Generator (Design Tool)

..... A, CATEKOR (Build Tool)
_‘, RL78 El (Serial) (Debug Tool)

..... ' Program Analyzer (Analyze T|| Using Debug Tool  » ‘

5[ File

- f Application (Subproject) ||§ Properly

T, ADC_OneShot (Subpraject)
ﬁ ADC_Repeat (Subproject)
-] _f_; Async_Serial (Subproject)
[ 5 DMAC (Subproject)
25, AL78 E1[Serial) Property
= Internal ROM/MRAM
Size of internal ROM[KEBytes]
Size of internal RAM[Bytes]
Size of DataFlash memom[KBytes]
E Clock
Main clock frequency [MHz]
Sub clock frequency[kHz]
Monitar clock
B Connection with T arget Board
Commiunication method
Power target from the emulator [Mas 200ma)
Supply voltage
El Flash

Security [0

Permit flash programming
Use wide valtage mode
Chip eraze when starting

=% AL78 E1[Serial) Property
B Download
Download files
CPU Reset after download
Eraze flazh ROM before downlaad
Automatic change method of event setting position
E Debug Information
Execute to the specified symbaol after CPU Reset

Specified symbal
Startup start synibol
Startup end spmbol

RL78 IECUBE
RL78 E1(Senal)
RL78 E20{Serial)
RL78 EZ Emulator
T8KOR Simulator

E4
4036
4

20.00
32.768
Spstem

1 line type [TOOLO)
Yes
5.0V

[FE] 00000000000000000000

Yes
Ve
Mo

1
Yes
Mo
Suspend event

Yes
_main
_{@cstart
_(@cend

The build configurations are selected from the build tool’s Property panel. The options available are
DefaultBuild, DebugBuild and ReleaseBuild. The DefaultBuild and DebugBuild are configured for use with the
debugger. The ReleaseBuild is configured for the final ROM-programmable code.

A common difference between the two builds is the optimisation setting and the addition of debug information.
With optimisation turned on, the debugger may seem to execute code in an unexpected order. To assist in debug-
ging it is often helpful to turn optimisation off on the code being debugged.

» Right-click on CA78KO0OR (Build Tool) from the
Project Tree.

« ‘Select Property.’

R20UT0460EG-0100 Rev. 1.00
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4. Project Workspace

« The Common Options sheet will open by default.
« Verify that the Build Mode is set to DebugBuild.

« Click on the Compile Options sheet to view com-
piler options.

« Ensure the ‘Add debug information’ entry is set
to “Yes (Add to both assembly and object file)(-

..... Za! RLTE Simulator (Debd G Build Project F7
----- ¥ Program Bnalyzer (4
3130 File

3+ ﬁ ADC_OneShot {Subp
]| ﬁ ADC_Repeat (Subpro
]| ﬁ Application (Subproj
]| ﬁ Async_Serial (Subpraj =
3/ DMAC (Subpraject) |

L I g'l'll‘" LF. EAFT AR L) PRy

Rebuild Project Shift+F7

Clean Project

Y Settn Default Build Option for Praject

Set Link Order...

Property

A, CATBKOR Property

E Build Mode
Build mode DebugBuild

= DutputFile Type andPath

;, Common Options ), Compile Options ,\'\ Assemble Options ,{ Link Options 4

[ Property |
A, CATSKOR Property
B Debuglnformation

Add_de_bug_inlurmalmn “Vesf4dd to both assembly and object file]-g2]
g2)’. = Pbtam ot Nolnal
« Ensure the ‘Optimization’ is set to No.
R20UT0460EG-0100 Rev. 1.00 - QEN ESNS Page 17 of 30
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RSKRL78G13 5. Building the Tutorial Program

6. Building the Tutorial Program

The tutorial project build settings have been pre-configured in the toolchain options. To view the toolchain options
double-click on CA78KO0R (Build Tool) from the Project Tree and select the available tabs. It is important when
changing settings to be aware of the current configuration before modifying the settings.

» Review the options on each of the tabs to be aware
of the options available. For the purposes of the tu-
torial, leave all options at default.
« When complete, the Property panel can be closed - W
by clicking [x] on the right-hand corner of the
Property window.

6.1 Building the Code

There is a choice of three shortcuts available for building the project.

Selecting the “Build Project’ toolbar button will build all projects listed in the project tree.

» Pressing [F7]. This is equivalent to pressing the ‘Build Project’ toolbar button.

7

» Selecting the ‘Rebuild Project’ toolbar button will rebuild all project files.

¢l B ¢

» Selecting the ‘Build & Download’ toolbar button will only build the active project and download the
code to the target device after a successful build.

» Pressing [F6]. This is equivalent to pressing the ‘Build & Download’ toolbar button.

Build the project now by pressing [F7] or pressing one of the build icons as shown above. During the build each
stage will be reported in the Output Window. The build will complete with an indication of any errors and warnings
encountered during the build.

R20UT0460EG-0100 Rev. 1.00 - QENES NS Page 18 of 30
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RSKRL78G13 5. Building the Tutorial Program

6.2 Connecting the Debugger

For this tutorial it is not necessary to provide an external power supply to the board. The power will be obtained
from the USB port. Please be aware that if you have too many devices connected to your USB port it may be shut
down by Windows. If this happens remove some devices and try again. Alternatively provide an external power
source taking care to ensure the correct polarity and voltage.

Other sample code supplied with this RSK will require a variable power supply; in which case an external 5V variable
power supply should be used. Refer to the RSKRL78G13 User Manual for further details.

The Quick Start Guide provided with the Renesas Starter Kit board gives detailed instructions on how to connect
the E1 to the host computer. The following assumes that the steps in the Quick Start Guide have been followed and
the E1 drivers have been installed.

» Fit the LCD module to LCD connector on the board, via the header marked ‘LCD’. Ensure all the pins of the
connector are correctly inserted in the socket.

« Connect the E1 Debugger to a free USB port on your computer.
« Connect the E1 Debugger to the target hardware ensuring that it is plugged into the connector marked ‘E1’.

« If supplying external power to the board please refer to Section 5.3 to turn off the option of supplying power
from the E1 before turning on the external power supply.

6.3 Connecting to the Target with the E1 Debugger

This section will take you through the process of connecting to the device, programming the Flash and executing
the code.

« Double click on CA78KOR (Build Tool) to open
the Property view.

[F==] 00000000000000000000

ethod

o In the Common Options tab; found under the & vesinseta

. Notes
Property view. Others

Security 1D

) Verify that the Security I D is Set to Specilies the security ID of the device that mounts flash memory.

Enter the security |D with a 20-digit [10-byte] number in hexadecimal

00000000000000000000 under the ‘Device’ en-
try.

1 Common Options \ Compile Options A Assemble Options A Link Options 4, ROMization Pracess Options ,(

Note:

The project has been configured not to use the Secu-
rity 1D feature.

If you have changed any project settings now is a File | Edit “iew Project Build Debug °
good time to save the project. News ,
« Select ‘File’ | ‘Save Project’. |« Open.. Ctrl+0
Add *

_i Close Project

[ Close CG_timer_user.c

é Save Project Ctrl+5hift+3
R20UT0460EG-0100 Rev. 1.00 RENES NS Page 19 of 30
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RSKRL78G13 5. Building the Tutorial Program

If you make any changes to files in CubeSuite+ and File | Edit “iew Project Build Debug
\t/)v;nt to preserve these change, you can save them M v B
. Select ‘File’ | ‘Save All’. & Open... Ctrl+0 |
Sdd r

& Close Project

;:L Close CE_main.c

|£ Sawve Project Ctrl +Shift+5

ﬁg'; Sawve Project fis..,

el Save CG_main.c Ctrl+5

B Save CG_main.c fs...

lEi:: CG_rnain.c Save Settings..

Gl Save Al Ctrl+Shifts8, |

You can also save files by clicking the ‘Save’ or ‘Save
All” buttons from the CubeSuite+ toolbar. E

You can also save files using the following keyboard Il N .l

shortcut:

R20UT0460EG-0100 Rev. 1.00 - QENES NS Page 20 of 30
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7. Downloading and Running the Tutorial

7.1 Downloading the Program Code
Now that the code has been built in CubeSuite+ it needs to be downloaded to the RSK.

e Click on the program
download button. Alternatively,
select Debug from the Menu
bar and click on Download.

52 woid main(woid)
« On completion of program B3 [{
a4 A% 3tart user code. Do not edit comment generated here */
download, the debugger and ac
code are ready to be executed. g6 /% Initimlize the LCD module. */
The program counter indicator o N
will point to first line of code g9 /% Display R3SE and sample name */
inside the main function; this is =0 Displaydtring (LCD_LINEL, "Renesas!)
th , t . t a1 Display3tring (LCD LINEZ, WICENALME) :
e program’s entry point. e -

7.2  Running the Tutorial

button to begin the program from the current program counter position. It is recommended that you run

Once the program has been downloaded onto the RSK device, the program can be executed. Click the ‘Go’ @
through the program once first, and then continue to the review section.
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8. Reviewing the Tutorial Program

This section will look at each section of the tutorial code, how it works, and how it could be altered to be imple-
mented into more complex code.

8.1 Program Initialisation

Before the main program can run, the microcontroller must be configured. Due to the debugger configuration used
for the Tutorial project and the rest of the sample projects, the user will not be able to step through the hardware
initialisation code as a result. Please refer to Section 5.3 to change the entry point after programming the microcon-
troller. Specify *_R_Systeminit’ as the function name if viewing of hardware initialisation is desired. The initialisa-
tion code is executed every time the device is reset via the reset switch or from a power reboot. The user is advised
not to use the ‘step’ feature of the debugger to exit the R_Systeminit function.

Ensuring the Tutorial program has been downloaded onto the RL78G13; press the ‘Reset & Go’ button on I«
the Debug Toolbar. *

» From the Menu bar select View > [E c6_main.c [#3 Disassemble1
Disassemble > Disassemblel. Al- | Zl[%1]3 | %8 % | view-
ternatively, use the Display Dis- 32 - DEns
assemble button to open and B80: b
view the ‘source and disassem- o K
H wold main(wvoid)
bly’. B83: {
R TO make the DISplay DiS&SS@m- :: /% Ftart user code. Do not edit comment generated here #/
ble button available on the tool- | =°: {7 Initialise the LCD medule. #f
. R 87 InitialiseDisplay!():
bar, right-click on the toolbar and wain:
&\ /i ] o041z fz520500 CALL ! _Initialiszelisplay
select “View Panels’. o
g9: /% Display RSK and sample nawe */f
N\ o0: Digplayitring (LCD LINE1l, "Renesas'):
EZZ oo4ia F009:z0 MOV LY, #Z009H
oo419 cl PUSH LI
od4la fa CLEW LI
o041k foezO500 CALL !!_Display3tring
o041t (=] FOF LE
Revert back to the source by clicking oL DisplayString (LCD LINEZ, NICENAME):|
. . . oog4zo Fo01izo Mo AX, #2011H
on the file containing the function o0423 = T R
pointed to by the program counter D4z 4 301000 MoV L%, #10H
indicator. Alternatively, right click in boazy RIS GAHL | el e EIEEag)
the Diassemblel window and click pRazh = FOF e
"Jump to Source"
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RSKRL78G13 7. Reviewing the Tutorial Program

8.2 Main Functions

This section will look at the program code called from with the main() function, and how it works.

« Right click the ‘FlashLEDs()’ B1|=/
function call and select ‘Go to = ‘{’E‘ld main(void)
Here’ to execute the program up 84 /* Start user code. Do not edit comment
to this line. The function “Initial- 85 ) )
. . , . =11 * Initialise the LCD module. *
iseDisplay()’ call initialises the - InitialiseDisplay (i
debug LCD and the ‘Dis- 58
playString()’ function calls will 2 /* Display R3IK and sawple name */

! . “ “ 20 Display3tring (LCD LINELl, "Eenesas'):
write the strings “Renesas “ and a1 DisplayString (LCD LINEZ, NICKMAME);
“RL78G13 ” on line 1 and 2, re- 9z

- 93 /% Flash the user LEDs for sSowe time or
spectively. a4 FlashLEDs | }-
95 EL] Register to Watchl i
=6 A lf‘lash e Register Action Event...
97 interru
28 TimerADC(] ]} Gota Here
99 "
100 i Dermjr'lst.rLal set PC to Here B
« Set a software break-point on the
“TimerADC()” function call by 93 /* Flash the user LEDs for some time
clicking on the On-Chip Break- 54 Sl | ) -

- a5
pomt column to the left of the g6 /% Flash the user LED3 at & rate 3et
number column. o7 interrupts. */

AP a5 TimerADC() :
« Click the ‘Step In’ button to step =
into the- FlashLEDs()’ function. 175void FlashLEDs [void)
Alternatively, press F11. 176§
177 /% Declare a loop iteration count variahle */
C»— F11 17a uint3iZ t ulled Delay:
— 179 uint§_t ucLEDecount:
150
« The program counter should now 51 /% Enskle SWi interrupts 7/
move into the FlashLEDs func- 182 INTP1_Enable () ;
- . el - - 1583
tion definition. Th!s function en- 1eia /% Ensble SU2 interrupts */
ables the external interrupts con- 185 INTP2_Enable(]:
H 154
nected to the user swﬂches_and 1o /* Ensble SUS interrupts +f
flashes the user LEDs 200 times 168 INTP4 Enable () ;]
H H 159
or Untll a user SWItCh haS been 190 /% Flash the LEDs for 200 times or until a user switch is
pressed. 191 for (ucLEDcount=0; ucLEDcount<200; ucLEDcount++)
13 3 192 {
» Press the Go bUtton to resume 193 f% If a user switch was pressed, exit the loop. */
program execution. 154 ifi glwitehFlag > 0x00)
. ) 195 ‘
« On exiting the loop, the function 196 break;
disables the switch interrupts and =7 ;

returns to the main function.
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RSKRL78G13 7. Reviewing the Tutorial Program

93 /* Flash the user LEDz for some time or until a
o4 FlashLED=1) :
95
=] /% Flash the user LEDs at a rate set by the use:
a7 interrupts. */
MLy os TimeriDC():
Q9
100 /% Demonstration of initialised wariables. Use -
101 debugger .+
10z Statics_Test():
103
« The program counter should 13; f’;_ll{altlan an infinite while loop @/

come to a halt at the TimerADC 1oe I{J tie (1l

function. 107 :
105 i

« Step over the function by click-
ing the ‘Step Over’ button. Alter-
natively, press F10.

=

The TimerADC function starts a
continuous A/D conversion and a
periodic timer whose period is up-
dated with the ADC result.

« Open the r_timer_user.c file i g
— — ) ) 73|__interrupt woid R TAUO Channell Interrupt (void)
Set a hardware break-point on the 74|t
. . . . = /% Start user code. Do not edit comment generated here #f
first line of code inside the .
R_TAUO_Channell_Interrupt in- 77 /% Toggle user LEDa #/
= LEDO = ~LEDO;
terrupt handler =] LED1 = ~LED1: ',g Register to Watchl
80 LEDZ = ~LEDZ:| i Reqister &ction Event..,
. . . . g1 LED3 = ~LED3:;
« Right click instruction > Break U GotoHere
Settings > Set Hardware Break 83 /7 Store the | @ SetPCto Here its of the variable */
R g4 gTimerADCperi|
» Execute the program by pressing == #® GoTo. Cirl+G
the ‘Go’ button. AlternatiVE|y, 85 £7 Ensure thal sy Jump to Function F12 Ft helow Ox75 */
87 if (gTimerADCp
press F5. - ‘ #™ Back to Last Cursor Position
g9 gTime| ™ Forward to Mext Cursor Position
32 ’ & Tag Jump Shift+F12
9z /% Update 15—it‘ﬂ| Break Settings >||@ Set Hardware Break
93 TORO1 = ogTime| i
a4 ¥4 Jump to Disassemble Al Set Software Break
95 f* Clear THO1 ¥ cut Ctrl+3% @a Set Read Break to
98 TMIFO1 = 0O; ) .
o Iy Copy Cirl+C ,{ﬂ Set Write Break to
95 /% End user c|[ Paste Chrl+ [l Set RAW Break to
EEIN . i
ao [l Cpenin MNew Panel @f ek lophich
01f/* Start user code for adding. Do not edit comment generated here */
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7. Reviewing the Tutorial Program

The program will halt at the
hardware breakpoint due to the
timer’s period elapsing.

Remove the hardware breakpoint
by clicking on the icon once.

Press F5 to resume program exe-
cution and observe the string on
the debug LCD’s second line
change one character at a time
from ‘STATIC’ to ‘TESTTEST’
as the Statics Test function is
executed.

After all characters have been
changed, the debug LCD’s sec-
ond line will display
“RL78G13".

Press the Stop button to halt pro-
gram execution.

This is the extent of the tutorial code.

AL

73| interrupt wvoid R_TAUOD Channell Interrupt (void)

74|

75 % Ztart user code. Do not edit comment generated here
76

77 /* Toggle user LEDs */

78 LEDO = ~LEDO;

=l LED1 = ~LED1;

20 LEDZ = ~LEDZ;

81 LED3 = ~LED3;

lz6|void Statics_Test (void)

1274
1zs
29
130
131
132
133
134
135
136
137
138
139
140
141
142
143
144
145
146
147
145
149
150
151
152
153
154
155
156
157
158
159
180
161
182
183}

/* Declare loop count varishle */

uints t uiCount;

/% Declare string wvariable to hold the string to be copied */
uint8_t usStr[] = "STATIC 407;

/% Declare varisble buffer to store the copied string */
uintd_t ucReplace[] = "TESTTEST,O":

/% Declare & delay count varishle */
uint3iz_t ulbelay;

"ITATIC" to LCD +/
(int8_t*juelcr);

/% Write ueStr varaible,
Displayitring (LCD_LINEZ,

/% Begin for loop which writes one letter of ucReplace to the LCD at a time
The nested while loops generate the delay bewteen each letter change */
for (uicCount=0; uiCount<d; uiCount++)
{
/% Replace letter numwber uiCount of ucltr from ucReplace */
ucitr[uicount] = ucReplace[uiCount]:

/* Display the character on the debug LCD */
DisplayString (LCD_LINEZ, (intd_t7)ucStr);

/* LED Flashing Delay */
for (ullelay=0; ulDelay<700000;
{

ulbelay++)

/% Delay */
}
H

/% Clear LCD Display */
ueStr[uiCount] = '40';

/% Write MCU nicknswe to LCD again */
DisplayString (LCD_LINEZ, NICKNIME);

For further details regarding hardware configuration, please refer to the RL78 Series Software Manual and the

RL78G13 Hardware Manual.

The E1 emulator features advanced logic-based event point trigger system, and full instruction on its use is outside the
scope of this tutorial. For further details, please refer to the E1 Emulator User’'s Manual
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RSKRL78G13 8. Additional Information

9. Additional Information

Technical Support
For details on how to use CubeSuite+, refer to [Help > Tutorial] from the menu bar within the CubeSuite+.
For information about the RL78G13 series microcontrollers refer to the RL78G13 Group hardware manual.

For information about the RL78G13 assembly language, refer to [Help > Tutorial] from the menu bar within the
CubeSuite+.

Online technical support and information is available at: http://www.renesas.com/rskrl78913

Technical Contact Details
csc@renesas.com

General information on Renesas Microcontrollers can be found on the Renesas website at:
http://www.renesas.com/

Trademarks
All brand or product names used in this manual are trademarks or registered trademarks of their respective com-
panies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of this
document, either in whole or part is prohibited without the written permission of Renesas Electronics Europe Lim-
ited.

© 2011 Renesas Electronics Europe Limited. All rights reserved.
© 2011 Renesas Electronics Corporation. All rights reserved.
© 2011 Renesas Solutions Corp. All rights reserved.
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